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Lesson Name: Create DTM using Data Acquisition tools
LESSON OBJECTIVE:
Using the Data Acquisition toolset, build a digital terrain model for future analysis exercises

Data Acquisition toolset

The Data Acquisition toolset is designed (at release — V8i SELECTseries 1) to provide the User with an
alternate set of tools to gather data from various sources, and then edit, merge, append and manipulate that
data to build a composite surface to begin the Civil Design process.

Supported data sources at this first release are:

Raw Survey (many formats)

Current Bentley DTM formats (DTM, TIN, FIL, LandXML)

Lidar Data (LIS and XYZ)

Raster data: SDTS, USGS DEM, TIF, Spot Dimap, NTF, Erdas IMG, BIL, ECW, DTEDO, DTED1, DTED2
The list of data sources will grow as the toolset matures.

The simplified workflow and interface, and the intuitive nature of the tool operations reflect a glimpse into
the future of Bentley Civil’s plans for better tools that provide more focused functionality and are easier to
use.
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EXERCISE: OPENING DATA ACQUISITION TOOLS

This exercise will guide you through the steps activate the Data Acquisition toolset.

1. Open MicroStation from the desktop icon

2. Openthe DGN file ... C:/2009 RBC/GW1/DATA/Aerial.dgn

3. Activate GEOPAK. (Applications Menu>GEOPAK>Activate GEOPAK).
GEOPAK may already be activated — in which case skip step 3

4. Select the Data Acquisition tool (Task menu>Data Acquisition>Data Acquisition)

Two new panels will open. The Data Acquisition data tree and the Data Acquisition Details panel. These
panels should both be docked. Location of the panels is a personal preference. The image of
the docked panels will provide an example arrangement.

M Aerial.dgn [3D - V& DGN] - MicroStation V8i (SELECT:
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EXERCISE: CREATE DATA ACQUISITION SURFACE FROM AERIAL DATA

This exercise will guide you through the steps to build a DA Surface from graphical data. In this
scenario, the data has been supplied from an Aerial photography company. Similar steps would apply
to the creation of a surface from any graphical 3D data.

1. Focus on the DA Data Tree.
2. Right Click on “Surfaces” folder.

3. Create Surface>Empty Surface.

Data Acquisition o
ik [:= &
Select | Details Geo Tool
=- I. Layout 2

----- -{¥]% Field Books

I .._J
Create Surface... k Empty Surface

From Field Book...
From Selection Set...

Import External Surface... L

4. A new surface will be created in the DA Data Tree: Surface 1
5. Drill down the Surface 1 data structure until you see the Surface feature list.

E!-I Layout 2
----- .J;] Field Books
EI .__,: Surfaces
=] Surface 1
i .J’J Composing Elements
----- .__,; Composing Surfaces
EI s Features
7% Spots
Dﬁ Breallines
T8 Triangles
[T Holes
Dﬁ?: MajorContours
D;{E?;: MinorCortours
=103 Hul
[ #) Island
{18 Voids
| !%) Break Voids
[ ® Drape Voids
-] #) Drape Boundaries
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We can now select the graphical data that corresponds to the different feature types and import that data
into the DA Surface.

6. Select Level Display. (Settings>Level>Display).

7. Disable the display for Breaklines and Voids levels

2 Level Display - View 1 =5 o R|E5S
==

'F;‘D:'{noﬂﬂ'@'

Aerial Total.dgn

Border
Border_outline
BorderPlot
Coordinate
DesBuildPad

DesChains

DesConstruct... -

8. Select all of the “Spots” graphical data

9. Return your focus to the Surface 1>Features list.
10. Right click on Spots label

11. Select Import Selection.

The selected graphical spot data has now been imported into the DA Surface.
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12. Disable the display for the Spots level and enable the display for the Breaklines levels
13. Select all of the “Breakline” graphical data

14. Return your focus to the Surface 1>Features list.

15. Right click on Breaklines label

16. Select Import Selection.

The selected graphical Breakline data has now been imported into the DA Surface.

17. Disable the display for the Breaklines level and enable the display for the Voids levels
18. Select all of the “Void” graphical data

19. Return your focus to the Surface 1>Features list.

20. Right click on Drape Voids label.

21. Select Import Selection.

The selected graphical Void data has now been imported into the DA Surface.

22. Enable the display for all levels. (Settings>Level>Display)

© 2009 Bentley Systems, Incorporated



EXERCISE: ENABLE DISPLAY FOR DA SURFACE FEATURES

This exercise will guide you through the steps to display surface features of a DA Surface

1. Focus on the DA Data Tree: Surface 1

N

Enable the check mark for Triangles.

The triangles for the Surface will now be displayed as transient graphics.

3. We can reset the Side Length and Dissolve options to “clean up” the outside triangles of the
dataset.

Focus on the “Survey Details” panel.
Select the Surface 1 item in the panel.

Reset the Side Length attribute to 120 <Enter>

A

Reset the Dissolve Option attribute to Side Length <Enter>
The Surface triangulation should now appear significantly different around the outer edges.

oo

Reset the Minor Contour attribute to 2 <Enter>

©

Reset the Major Contour attribute to 10 <Enter>

£ Hement Enor List | %+ Adustment Resuts | [] Ouput |

| Ereaklines | Major Contour | Minor Contour | High Range | Low Range | Creation Type | Field Book
166187218, 165634842 - Graphic
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Return focus to the Surface 1 feature enablers on the data tree.

10. Enable Major Contours and Minor Contours features.
Data Acquisition o

4 = a
Select | Details Geo Tool

E|" Layout 2
Jﬁ Field Books
SR e Surfaces|
=[] Surface 1
-z Composing Blemerts
:.:"_,- Composing Surfaces
£ Features
-[F% Spots
~{"|Z% Breaklines
-~ Trangles
Holes
{35 MajorContours
f‘;ﬁ MinorContours
7.5 A
M%) Island
~{T] ) Voids
~{"| % Break Voids
~{| % Drape Voids
~{T]#) Drape Boundaries

EXERCISE: EXPORT SURFACE 1 TO GEOPAK TIN

This exercise will guide you through the steps to export a DA Surface to a native Bentley Civil
Application DTM. For this workshop, we will export to a GEOPAK TIN.

1. Focus on the DA Data Tree: Surface 1
2. Select Surface 1.

3. Right Click>Export to>GEOPAK TIN

4

Navigate the Save As dialog to the folder C:/2009 RBC/GW1/DATA and key in the file name
Surfacel.tin.

5. Select Save.
This will create a GEOPAK TIN named Surfacel.tin.

6. Close Data Acquisition data tree.
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Lesson Name: Create Finished Surface DTM using Corridor Modeling tools
LESSON OBJECTIVE:
Using the Corridor Modeling toolset, build a design surface digital terrain model for future analysis exercises

Corridor Modeling

The Corridor Modeling tools with GEOPAK are designed to interactively create Highway and Roadway designs
using a template based system that provides instantaneous visual feedback during the design process.

We will create a proposed highway project and generate a DTM of the finished surface — and then merge that
finished surface into the existing surface we created using the DA tools.

That composite surface will them be used as we explore the DTM>Analysis tools.

EXERCISE: CREATE HIGHWAY CORRIDOR DATA IN CORRIDOR MIODELER

This exercise will guide you through the steps to create Highway design data and a design DTM from
the Corridor Modeling tools.

As this workshop is not designed to teach Corridor modeler, a number of data files have been pre-
populated to expedite the process.

1. Select Applications>GEOPAK>Road>Corridor Modeling

&b Corrider Modeling [ = |[=

File Tools

i 44 A

b (399 | Qv A RS
[ Preferences Preferences
B ooe
B DM
B Geometry Station Lock: |Increment -
B Plan Graphics Slope Readout: [50% *
B3 ALG Viewer Horizortal Chord Height: | 0.100000

Vertical Chord Height: | 0.050000

Template Library: | C:\Program Files"Bentley"Geopak V8.1 1 \bin‘\default il Q

2. File>Load>MainRoad.rdp.
3. Select GPK file: job999.gpk
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4. Select DDB item. The active DDB file should be default_styles.ddb.

5. Select Import.
If a message appears that says file is already imported, cancel out of this operation and move to next step.

Select DTM item. The dialog should already include the file C:\2009 RBC\GW1\DATA\NoVoids.tin

~N o

Select Import.
If a message appears that says file is already imported, cancel out of this operation and move to next step.

8. Select Geometry item. The dialog should already have one row populated with data (shown
below).

Open Roadway Designer Drive Roadway

&b Corrider Modeling ‘ ‘ [ = |[=
File Tools
i ‘4 4
b (399 | Q[ 4 [t 2
B Preferences Chain Profile Dirafting Standard
B DDE MAINRD PROPOSED Certerine ]
B DM
1 Geometry
3 Plan Graphics X
B ALG Viewer
Chain: [MAINRD - I Profile(s)
Drafting Standard: [Cerrterline "] FROPOSED

9. Select the row and select Import.

This completes the steps required to import GEOPAK data into Corridor Modeling.

10. Select Open Roadway Designer.
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¥ '| Roadway Designer -

0
[
N

File Corridor Superelevation Tools

Close | | Help

=M ¢ 3

L EE =" 3
Comidor: | -| Station:  [fe] |?|ﬂ
Active Suface: [ NoVoids -] - Interval: 0.000
Template: Display Mode: @ Momal
Superelevation
Overday

11. File>Open>MainRd.ird
12. Set Corridor =MainRd
13. Set Active Surface = NoVoids

14. Select Fit button in each view of the Roadway Designer application dialog.

12




5 | Roadway Designer - C:\2009 REC\GWI\DATA\MainRd.ird
File Corridor Superelevation Tools

F=hoH-tou

Comidor: | MainRd -] Siation:  [j<][ <] 0.000 =& ﬂ [ Process Al |

Active Surface: |NOVnids v| - Interval: 50.000 [ Process Visible Range |
Template: 4 Lane Rural Display Mode: @ Nomal
Superelevation
Overday

15. Select Process All.

The Roadway Designer will calculate and process the template drops at 50 foot intervals for the complete
length of the corridor.

16. Close the Results pop up dialog.
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17. Corridor>Create Surface

Create Surface @
Name: Fiinished Suface -
Default Preference: [Defauﬂ ']
Create Surface(s) from:
\MainRd ]

Help

Mone

General Options
[ New Surface for Each Comidor [ | Create Altemate Sufaces

Empty Design Surface [ "] Process Visible Range Only
[ Include Null Paints Remove Loops

Triangulate
Features

@ Append Replace Rename Maodify

[7] Add Transverse Features

Styte: Aggregate
Add Bderior Boundary

S Aggregate -
Densify using Chord Height Tolerance Display in Plan View
Horizortal Curves Features
Vertical Curves Components

18. Populate the dialog as shown above.
19. Select Apply.
Both an InRoads DTM and a GEOPAK TIN file will be created following this step.

20. Close the Results pop up dialog.
21. Close the Create Surface dialog.

22. Close the Roadway Designer application dialog.
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EXERCISE: CREATE “DRIVE THROUGH” OF YOUR ROADWAY DESIGN

This exercise will guide you through the steps to create a “drive through” of your roadway design.

There has been some view settings enabled with View 5 of the DGN. We shall generate the drive

through from that view.

Hint Please stop and listen to your Instructor before proceeding with this exercise!
1. Applications>GEOPAK>SITE>DTM Tools.
2. Load DTM Features — Triangles.

DTM
B O 5 e o)

Load DTM Features

3. Populate the dialog as shown below. Select Load.

&4 Load DTM Features El = @
File
Load Fie: [TIN___ | | Surfaca1tin Q,
Display Preferences

Load: |Extent »| [ Display Cnly Graphic Group

Feature Level Color |Weight| Style | Display =
Triangles 12 84 Bylv ByLv ON |[Z]| %t
TIN Hull Default 1 0 0 OFF |2 ot
Contours - - - - OFF

'.'E or Lines Nef=n b : 1 1 ::::: Q
4 s

Open View 5.
IMPORTANT: DP in View 5 to ensure it is the “Active” view.

Select Drive Roadway button from Corridor Modeling dialog.

N oo g &

Populate the dialog as shown below.
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8. Select Run.

© 2009 Bentley Systems, Incorporated

Drive Roadway

Horizantal Alignment:

Vertical Alignment:
Horizontal Offset:
Vertical Offset:
Speed:

Frames per Second:
Start:

Stop:

Target Distance:

1

[ L
g
[

[MAINRD v

PROPOSED - Display

17.000

Cloze
3.500
Preferences..
30.000
Hel
2 p

:
g
[+ 1+ 1+

16



EXERCISE: CREATE OVERALL DTM (EXISTING + DESIGN SURFACES)

This exercise will guide you through the steps merge the Roadway surface (Finished Surface.tin) and
the existing surface (NoVoids.tin) into a single surface.

1. DTM>Build Merge TINs.

'rlurw .R i TR 2e

Build Merge TIN

L Merge TIN Files =] @ =3
Old TIN: | NoVoids fin Q
Mrg TIN: | Fiinished Surface tin Q.

: Q

Process

2. Populate the dialog as shown above:
a) The “Old TIN” is the existing surface
b) The “Mrg TIN” is the roadway surface
c) The “New TIN” is the TIN that will be created as a result of the merge process.

3. Select Process.
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Lesson Name: GEOPAK DTM Tools
LESSON OBJECTIVE:
Initially, we shall locate the GEOPAK DTM tools and review the available toolset

EXERcISE: DTM MENU — REVIEW TOOLSET

This exercise will guide you through the steps to access and open the GEOPAK DTM tools and we will
review what capabilities are available.

1. Openthe DTM toolbox. (Applications>GEOPAK>Road>DTM Tools)

DT £

=] 115 LN SO g Lol

Open the DTM menu bar.

# DM = = =

Settings Extract Build Edit Drape Load Reports | Analysis | Utilities

N

We shall now review the available menu items and the tools available from the menu items

3. Extract: Tools to create/append data to “DAT” files. The DAT file is a method for gathering
accumulating data to be built into a DTM.

4. Build: Tools to build TIN and Lattice files. The TIN is built from a DAT file or from an existing TIN
(merge/clip options). The Lattice files can only be built from an existing TIN.

5. Edit: Tools to edit/modify a DAT or TIN file. Tools include filtering points for proximity or
overlapping (and elevation mismatched) breaklines within DAT files or the dynamic editing of
elements with a TIN file.

6. Drape: Tools to create 3 dimensional graphical elements by referencing 2D elements to a DTM
surface.

7. Load: Draw or display the elements from with the different GEOPAK DTM files (DAT, TIN, Lattice).
8. Reports: Simple reports to provide feedback regarding data within the DAT/TIN or Lattice files.

9. Analysis: The focus of this session. A series of tools to analyze the DTM surface for design
purposes. These tools are specifically designed to review an existing surface and allow the
Designer to become familiar with the site before commencing their design project.

10. Utilities: Tools to convert the DTM files to different formats and systems including exporting the
DTM data to machine control formats.
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Lesson Name: Editing Triangles

LESSON OBJECTIVE:

A myriad of tools to interactively edit TIN models are located in the TIN Edit Tools dialog. The triangulated
model can be dynamically edited in terms of adding, deleting or moving spot elevations. Break lines can be
added, draped or deleted. As editing is initiated, resultant triangles, contours, flow arrows, and voids are
optionally displayed "on the fly."

The objectives of this lesson are:

1) Become familiar with the editing options that are available within the GEOPAK TIN Editing tool.
2) Know when to utilize the available tools and when not to.
3) Use a sample of the tools and become comfortable with their operation.

The list box on the left side of the dialog # Edit Triangles E=]E=]
contains the editing options. As each Preferences
tool is selected, the right side of the T A
dialog dynamically changes to reflect Delete Vertex
the current tool. All these editing mm xertexg*r
H ove Vertex
features dynamically show the changes Polygon Move Z ]
as they occur. In addition, the changes Delete Lins
are not written permanently to the Swap Line
triangulated model until the user selects Insert Braak: Line

the Save button. This allows the User insert Drape Line

Delete Trianale x
the option of saving their modifications
(Save) OR rejecting the modifications TIN Update
(Undo To Last Save). Undo To Last Save |
Save
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EXERCISE: EDITING TRIANGLES — SETTINGS FOR TOOL

This exercise will guide you through the steps to get started.

1. Select DTM Menu>Edit>Triangles

Display Settings
Q, Edit View: [1_~]
Display Triangles J —
Display Cortours Color Weight Style

7]
v

*]

- e

Minor Interval: | 5.00 J ( =]
Major Interval: | 25.00 ! ( =] [

Display Hul B (/|
[] Display Break Lines J
[ Display Bxd. Contours J
Display Voids ! [——=| [——=]
[] Display Islands !

[] Display Flow Amows !

Flow Amow Size: | 2.50 [ oK ]I Cancel I

- —_—

- e

- e

2. Populate the Display Settings dialog as shown. Color settings shown are not mandatory — set
colors that will be easily distinguished from the original data.

The Edit Triangles dialog cannot be accessed until the Display Settings dialog is closed.

Tin File: aerial.tin
Edit View: 1
Display Triangles Enable
Display Contours Enable
Minor Interval 5
Major Interval 20
Display Hull Enable
Display Voids Enable
3. Select OK.

EXERCISE: EDITING TRIANGLES — DELETE LINE TRIANGLES

This exercise will guide you through the steps to select triangles by line for removal.
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1. Scroll to the bottom of the editing options.
2. Select Delete Line Triangles.

3. Select Place Delete Line and place a line in the plan view that crosses the triangles you wish to
delete. An example is shown below.

&L Edit Triangles =] @ |z

Preferences

Delete Vertex -
Move Vertex XY
Move Vertex Z
Palygon Move £
Delete Line
Swap Line

Insert Break Line
Insert Drape Line
Delete Triangle
Delete Line Trangles  ~

m

TIN Update Delete Line Triangles
| Undo To Last Save | Place Delete Line
Delete Line Triangles

4. Select Delete Line Triangles to remove the crossing triangles.
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EXERCISE: EDITING TRIANGLES — DELETE TRIANGLES
This exercise will guide you through the steps to delete individual triangles.
This tool is typically used to delete “sliver” or “edge” triangles. The typical workflow is to select triangles,

starting outside the edge of the TIN and working your way in. If you select an internal triangle
and delete it, you will create a “void”.

1. Select Delete Triangle.
M Edit Triangles =R oR 5

Preferences

Delete Vertex -
Mowe Wertex XY
Move Vertex Z
Palygon Maove Z
Delete Line
Swap Line

Insert Break Line
Insert Drape Line
Delete Trangle
Delete Line Triangles ~

m

TIN Update Delete Trianale
Undo To Last Save
I |d Triangle
Save l—]

2. Select Id Triangle.

3. Starting just outside the triangle you wish to delete and DP with your mouse. The triangle inside

your current location will be deleted.

4. Continue deleting until the triangulation outer edge is as expected (or the Instructor says stop).
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EXERCISE: EDITING TRIANGLES — INSERT BREAKLINE

This exercise will guide you through the steps to insert additional breaklines into your DTM.

1. Select Insert Breaklines.
2. Two options are provided.
a. Place: the User places the proposed breaklines interactively
b. Select: The User selects existing graphical features and those are inserted as breaklines.

3. Select Place. A second dialog will appear. This dialog allows the user to set constraints and snap
options for how the breaklines will be inserted.

&L Define Break Line [ = ===
DP1 DP2
~) Active Elevation ~) Active Elevation
@ Drape =/~ | 0.0000 @ Drape =/~ | 0.0000
") Hevation = | 0.0000 ") Hevation = | 0.0000
Slope = 00000 h

DTM Snap:; [Vetex  ~]

Start Insert _ dz = D000

4. Setthe DTM Snap to Vertex.
5. Set DP1 and DP2 to the Drape option.

There are many options for the placement of DP1 and DP2. Most are self explanatory. Any options that
are unclear should be discussed in the class.

o

Move to an open area of the triangulation and begin placing breaklines across existing triangles.

~

Select Insert to apply the breaklines.

This will add the breaklines. The dataset will re-triangulate and redisplay immediately. The elevations at
each end of these new breaklines will be the same as the existing triangle vertices that the lines
commenced and ended at. There will be a straight grade between the vertices.

8. Close the Define Break Line dialog.
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EXERCISE: EDITING TRIANGLES — DELETE LINE AND SWAP LINE

This exercise will guide you through the steps to Delete or Swap triangle edges.
As both of these tools operate similarly, we'll ook at these two tools in this single exercise.

1. Select Swap Lines.
2. SelectId Lines.

3. Move into the display and select a triangle edge that is shared between two triangles.

4. The tool will rearrange the triangle edge as shown above.

5. Select Delete Lines.

6. SelectId Lines.

7. Move into the display and select a triangle edge that is shared between two triangles.
8. The tool will delete the selected triangle edge.

The Delete Lines tool will create a void within your DTM surface.
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EXERCISE: EDITING TRIANGLES — ADD VERTEX AND DELETE VERTEX

This exercise will guide you through the steps to Add or Delete a triangle vertex.
As both of these tools operate similarly, we'll ook at these two tools in this single exercise.

1. Select Add Vertex.

&b Edit Triangles [ = |[=

Preferences

Add Vertex -
Delete Vertex
Mowe Wertex XY
Move Vertex Z
Pahygon Move Z
Delete Line
Swap Line
Insert Break Line X | 0.000000

Insert Drape Line DP Y : | 0.000000
Delete Trangle - Z- 0.0000
TIN Update

Undo To Last Save
- Add
Save

m

Add Vertex

2. Select DP.

3. Move into the display area. Note that triangles are automatically added as you move the cursor
around the plan.

4. DP to locate the new point. The X, Y & Z values are populated in the dialog. The User can edit
these values in the dialog.

5. Select Add. The point is written to the DTM surface.

Add more vertices — edit the elevation before adding the point to the data. Add a point inside a void. What
is the outcome??
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6.

7.
8.
9.

10.
11.
12.
13.
14.
15.
16.
17.
18.
19.

Select Delete Vertex.

& Edit Triangles [ = ===

Preferences

Add Vertex -
Delete Vertex
Mowve Vertex XY
Move Vertex 7
Polygon Move Z
Delete Line
Swap Line

Ingert Break Line
Insert Drape Line
Delete Trianale 7

TIN Update b Re-Triangulate
Undo To Last Save Create Void

Save

m

Delete Vertex

The Delete Vertex>Edit options allow the User to re-triangulate the surface or to create a void.

Set Edit option to Re-Triangulate.

Select Id Vertex.

Move into the display area.

DP to select a triangle vertex. The vertex and all attached/effected triangles will highlight.
DP to accept the delete.

The modified triangulation will redraw.

Continue...

Set Edit option to Create Void.

Select Id Vertex.

Move into the display area.

DP to select a triangle vertex. The vertex and all attached/effected triangles will highlight.
DP to accept the delete.

The modified triangulation will redraw.

This will end our editing session. There are more editing tools available and these can be discussed

and attempted within the class as time permits.

We will now move on and examine and use the Analysis and Visibility tools
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Lesson Name: DTM Analysis tools

LESSON OBJECTIVE:

Review available Analysis tools. Become familiar with the tools; their purpose and the value to the designer.

EXERcISE: DTM ANALYSIS TOOLS

This exercise will guide you through the steps to evaluate the value of and use the available DTM

Analysis tools.

1) Review available DTM>Analysis tools.

“# oTMm ol® ==
Settings  Extract Build Edit Drape Load Reports | Analysis | Utilities

Height/5lope

Profile

Volumes

Elevation Differences
Slope Area

Themes

Drainage Tools
Visibility

Trace Slope Path

Camera

Trench Volumes

DTM>Analysis menu

Analysis

i GEO T M A B

DTM>Analysis toolbox
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2) Available tools:

a)
b)
<)
d)
e)
f)
8)
h)
i)
)
k)

Height/Slope

Profile

Volumes

Elevation Differences
Slope Area

Themes

Drainage Tools
Visibility

Trace Slope Tools
Camera

Trench Volumes

We shall now discuss and use each of these analysis tools.

Height Determine Elevation and Slope at locations within the TIN
model.

Profile Extract Profile/section at any location in the TIN model.

Volumes Compute volumes between two TIN models or TIN to Plane.

Elevation Difference Generate grids, or contours of elevation differences.

Slope Area Displays the horizontal area and actual slope area of a specified
shape.

Themes Analyze TIN file in terms of elevation, slope, or aspect ranges.

Drainage Tools Analyze and evaluate TIN model from a drainage perspective.

Visibility Determine visibility of triangles from a given point on the model.

Trace Slope Path Traces a path along a TIN file from a user defined origin.

DTM Camera A wide variety of tools and options to view Digital Terrain
models within a MicroStation 3D file.

Trench Volumes Computes the trench and bedding volumes for pipes in a

drainage and / or water sewer project. The User requires
Water/Sewer and/or Drainage project data to use this tool.

© 2009 Bentley Systems, Incorporated 28



EXERCISE: HEIGHT/SLOPE TOOL

This exercise will guide you through the steps to get started using the Analysis>Height/Slope tool.

The Analysis>Height/Slope tool will provide the user with instantaneous visual feedback regarding a
selected surface for the elevation and slope direction for any location on the Surface. Also, at any
selected point, the contour for that elevation will be shown across the entire surface — providing the
User

1. Select the Height tool. (DTM Tool Frame: Analysis > Height).
&L Height / Slope =] = =]

TIN File: | Aerial tin Q
Mode : |Elevation - Display Cnly
Cptions

o |
Show Contour: !
Show Triangle: J
Show Flow Amow: J

Cursor Point Values

X - 1659811.90

Y : -275361.02

Z - 105563
Slope : 13.84%

TIN File C:/2009 RBC/GW1/DATA/Aerial.tin

Show Contour Enable, Red

Show Triangle: Enable, Green

Show Flow Arrow: Enable, Blue

2. Click Start.

3. You can now move the mouse cursor into the area of your DTM. As you move around, the
Height/Slope tool dynamically displays the elevation, the direction of slope and the current
elevation contour in the symbology color set in the dialog.

The text attributes for the elevation are set within the Text sample graphic. Double click the black text
rectangle to reset the text attributes.

4. A Data Point (DP) will provide a snap shot WYSIWYG. All activated options will be drawn to the
CAD file at the location of the DP.

5. Reset when finished (right mouse button).
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6. Inthe Height/Slope dialog, change the Mode option to Slope.
&b Height / Slope [ = |3

TIN File: | Aerial tin Q

Mode : | Slope =| [¥] Display Onty
Slope Display Options

~

Display |Slope % x|
(Z) Triangle Slope
@ Slope between points

Cursor Point Values

X : 1659811.90
Y - -275361.02
Z : 1055.63

] Slope - 13.84%

1l Distance:

/[ Delta Hev

In Slope Mode, the tool is designed to provide the User with slope value feedback. The slope values can
be toggled between Triangle Slope and Slope between points.

Set the Slope Display Options to Slope % and activate Slope between points.
8. Enable the Slope, Distance and Delta Elev options.
9. Click Start.
10. Data point in two locations to review the slope between them.
11. Close the Height/Slope dialog.

Please Note: The Display Only toggle provides the User with the option to write the analysis data
to the CAD file or simply display the analysis data. Enabling the option will display the data.
Disabling the option will write the data to the CAD file.
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EXERCISE: PROFILE TOOL

The Profile tool allows the user to select one or more TIN files (and/or Models and Objects when
invoked within Site Modeler) and create “quick” profiles of that surface (or those surfaces) at any
location desired.

The User has the option of setting profile scales and grids, selecting an existing graphical element to
create the profile along or striking a new location along which the profile will be cut.

The profiles can be “quick viewed” inside the available viewing panel OR they can be drawn into the
CAD file.

1. Select the Profile tool. (DTM tool frame: Analysis > Profile).

&b Profile [ = |[=
File
Type | Feature Level Color |Weight| Style | Bdract |
TIN Aerial tin ExProCL & 2 0 On E
. bt
Add List ltem
4
Select File =
f=in]
w
(TiNFie___~) [Aeraliin - —

Create Legend

N

Select C:/2009 RBC/GW1/DATA/Aerial.tin using Select File.
Set the profile symbology by double clicking the sample line graphic.

w

Hint This will activate the Set Feature dialog.

4. Select OK to close Set Feature dialog.
5. Select Add List Item icon (top icon, right side of list).
6. Select Create Profile button.
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&L profile =m el =

File

W ‘ j{ / Curve Stroking: | 0.000

Select Profile Place Profile Place Profile
Element Element

7. Click Place Profile Element and data point (twice) to define the beginning and endpoints of the
desired profile.

Hint The extracted profile is displayed in the dialog.

&b Profile = B [
File

ﬁ }%{ / Curve Stroking: | 0.000

8. Right click the mouse button to reset.

Hint To extract another profile, select the Place Profile Element button again and data point in
MicroStation View 1.

9. Select the Profile Preferences button.
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10. Populate the dialog as shown below.

11. The Elevations and Stationing values are automatically read directly from your TIN file. These can
be modified by the User to provide “space” around the profile graphic itself, if desired. The
Elevation>Rounding options will assist.

&b Profile [ = |[=
File
— Blevations
@ Minimum;: | 1058.000 | Round Down minus: | 2.00

5

Magmum: | 1071.000 F Round Up plus: | 2.00

| Reset Vertical |
Vertical: | 1.000 Stationing
Boundary Minimum: | 0.000
Symb: | — Maxdmum: | 308.060 |  Reset Stations |
Horizontal Grid Vertical Grid
| Major Interval: | 50.000 V| Major Interval: | 5.000
Minor Interval: Minor Irnterval:
Major Symbology: | — Major Symbology: | EE—
Minor Symbology: | Minor Symbology: |

Major Tead:

Major Texd:

12. Switch back to the Profile Tab to see the grid.

# Profile o || = [ =
File

13. (Optional) Select Place Profile and data point in the desired location in MicroStation View 1.
14. The profile, as seen in the preview window, will now be drawn into the DGN.
This is a static profile and does not automatically update if the surface should change.

15. Close the Profile dialog.
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EXERCISE: VOLUMES CALCULATIONS TooL

The Volumes tool provides the user with either Prismoidal or Grid based DTM volumes between a

single surface and a plane or between two surfaces.

Other options available on the tool dialog include the ability to calculate volumes within different
elevation ranges (useful when calculating retention pond requirements), within a prescribed
boundary, within multiple regions, to factor in different cut/fill bulking and shrinkage factors and to

output the results to an ASCII file.

1. Select the Volumes Calculations tool. (DTM tool frame: Analysis > Volumes).

&L Volume Calculations | = | = [Z3]

Caleculation Method i
@ Ii @) Gid Points: [ 100 Select Calculation method
Calculation Options

Calculation: |Plane to TIN -

From Plane: | 1100.000 Select Calculation options.

To TIN: | Aerial tin Q - Optionally: Set elevation ranges to
calculate volumes within
[7] Use Range: Range
Volume Calculations
[] Use Factors:
cut: [ 100 Al [1.000 ‘ Displays Volume results.
C,_El'ltl 52:5:2 Optionally: Enables cutfill factors
Balance :
Area : &

Output

Output To ASCII File: _

:an'am a Optionally: results can be

: autput to ASCIl file
Wiew...

Boundary Selection _

[7] Use Boundary: Place Select Optionally: Volumes can be calculated
[F] Volumes By Region: | Regions within a boundary or regions
Volume Polygons .

Displa},hogn,y [rmm— Optionally: The plan areas of the

i Volume P % volume calculations can be
(B Vel e displayed graphically

Set Calculation Method to Prismoidal.

Set Calculation Options to “Plane to Tin”.

Set From Plane value to 1100

Set To TIN as C:/2009 RBC/GW1/DATA/Aerial.tin
Select Process

o gk N
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Other options will be discussed and implemented in the class. Having a single existing surface TIN file
makes some of the options and calculations redundant.

EXERCISE: ELEVATION DIFFERENCES TOOL

The Elevation Differences tool provides the user with elevation differences between surfaces. The
Surfaces can be a TIN (and/or Object or Model in Site Modeler) or a Plane. The combination and
order of the surfaces/planes to be analyzed can be manipulated by the User.

Available analysis options are:

1) Difference Point
2) Difference Grid
3) Cut/Fill Grid

4) Cut/Fill Contours

1. Select the Elevation Differences tool. (DTM tool frame: Analysis > Elevation Differences).

&L Elevation Differences E =] @
Calculation: | Plane to TIN hd

rrom Plene: | TR0 —Set calculation option
o TING |1 Q
Option . -
(Dfference Point w) [ Cut: |l Select analysis type/option and
[ Rl | — symbology settings
P Difference Point
Even: *_ ! !
[7] Dynamic HEe Difference Grid
Cut/Fill Grid

Cut/Fill Contours

Display
e R Li Set Display options

F [7] Planarize at:

Boundary Selection

e Boundan — == : Optionally: Enable Boundary

Selection

I Process J

Set Calculation to Plane to TIN.

Set From Plan to 1100

Set To TIN to C:/2009 RBC/GW1/DATA/Aerial.tin
Set Option to Difference Point.

Enable Cut/Fill/Even and set symbology for each.

No ok~ wd

Enable Display>Display Only (graphical result data will not be committed to CAD file).
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8. Select Process. Move the cursor into the graphics and DP.

At each DP point, the difference in elevation between the Plane value and the TIN will be calculates and
displayed. Continue to DP. You will see different symbology as the values move from negative
to positive (cut to fill). The Analysis>Height tool can be optionally enabled and used to verify the
results you see.

9. Return focus to the dialog.
10. Enable Dynamic and select Process.
The tool will now return real time results as you move the cursor over the data.

11. Set Option to Difference Grid.

&L Elevation Differences El =] @
Calculation: | Plane to TIN -

From Plane: | 1100.000

To TIN: | Aerial tin Q
Option
{ Difference Grid - cut: [ —
Al —
Even: |E—

Grid X Interval: | 10.000
Grd Y Interval: | 10.000
Display
Display Cnly [] Set Graphic Group
F [7] Planarize at:
Boundary Selection
[7] Use Boundary: Place Select

I Process

12. Set the Grid Intervals to 10.

13. Set text height/width to 1.00 (double click in text sample graphic to enable the Set Feature
dialog).

14. Select Process.

At an X/Y grid of 10/10, the elevation differences will be calculated and displayed in the graphics. The “cut”
values will be displayed in green. The “fill” values will be displayed in red. The “even” values will
be displayed in brown (these are at elevation 1100 — same as the plane). These values could
be written to the CAD file permanently as part of a construction document set when an existing
and proposed surface is used.
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15. Set Option to Cut/Fill Grid.

&b Elevation Differences =] @ =3
Calculation: | Plane to TIN hd

From Flane: | 1100.000

To TIN: | Aerialtin @
Option
Cut/Fill Gid ) cut: —
Fil: [ —
Even: | E—
Mumber of Grid Points: | 200000

Display
Display Onby [] Set Graphic Group
Fill [] Planarize at:

Boundany Selection
[] Use Boundary: Place Select

16. Set Number of GRID Points to 200,000.
17. Enable Display>Fill
18. Enable View Attributes>Fill. (MS menu>Settings>View Attributes)
19. Select Process.
Grid points will be created across the TIN area and elevation differences will be calculated. The grid will

then be colored based on selected symbology settings for cut/fill/even. With the Display>Fill
option enabled and the View Attributes>Fill enabled, the areas of cut/fill will be filled.
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20. Set Option to Cut/Fill Contours.

#L Elevation Differences =] @ =3
Calculation: |Plane to TIN hd

From Plane: | 1100.000

To TIN: | Aerial tin
Ciption
Cut/Fill Contours ~ + Cut:

a
_
(7] Even: | —

MNumber of Grid Points: | 200000
Contour Blevation Interval: | 2.000
Contour Label Interval: | 100.000
Display
Display Cnly [] Set Graphic Group
F [7] Planarize at:
Boundary Selection
[7] Use Boundary: Place Select

I Process

21. Set Contour Elevation Interval to 2.0
22. Set Contour Label Interval to 100.0

23. Enable the Label. Set the label height/width to 5.0. Set Label decimals to 0.

24. Select Process.

Isopac contours will now be displayed in the CAD file. These contours show the elevation difference

between the Plane (elevation 1100) and the TIN surface. Again, a useful inclusion is a
construction documents set to show where the cut/fill is across a site AND the depths.

25. Close the Elevations Differences dialog.
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EXERCISE: SLOPE AREA ToOL

The Slope Are tool provides the user with a TIN surface area for any defined plan area. The tool will
intersect the plan area with the Surface and calculate the actual triangle surface areas within that

plan area.

The steeper the terrain, the larger the difference between slope and plan areas will be. Conversely,
the flatter the terrain, the less the difference between slope and plan area will be.

One example usage for this tool is area of grass required for replanting or stabilization.

1. Select the Slope Are tool. (DTM tool frame: Analysis > Slope Area).
o Slope Area El =] @

TIN File: | Aerial tin Q

Area Calculations
Area : 782358163 5Y
Area Slope : 829804 557 5Y

Boundary Selection
[] Use Boundary: Place Select

Slope Polygons
Diplay Oty |
[] Fill Polygons

Process

2. Select the file C:/2009 RBC/GW1/DATA/Aerial.tin

3. Select Process.
The Plan Area (Area) and Slope Area of the entire surface will be calculated and displayed.

Hint Other options allow the User to select or place a boundary for calculation within that designated
area.

4. Close the Slope Area dialog.
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EXERcISE: THEMES TooL

Various theme options are available when using the Themes Tool:

AVAILABLE ANALYSIS OPTIONS ARE:

1) Elevation Range

2) Slope Range Percent
3) Slope Range Degree
4) Slope Aspect

1. Select the Themes tool. (DTM Tool Frame: Analysis>Themes)
L Themes -> Elevati... [ = || & |[Z3a]

VPO 4

TIN File: | Aerial tin Q.

DeplayOrty [ —

[ Load Within Fence
[ Set Graphic Group
Fil

Options
[7] Planarize at Elevation:
[ Polygonize Results

Set Range Process

2. Select Elevation Range.

3. Set the following items on the dialog.

TIN File: C:/2009 RBC/GW1/DATA/Aerial.tin
Display Only: Enabled
Fill: Enabled
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4. Select Set Range. (Bottom left of dialog)
&b Elevation Range =] @ =3

File

Range: [Auto Range Increment = |
Auto Range Options
Range Increment: | 20.000

Minimum Blevation: | 380.000 551.091
Maxdimum Blevation: | 1120.000 1165817

Set Range J I Create Legend I

Low High Color Active =
580.000 1000.000 ] YES = [
1000.000 1020.000 1 YES
1020.000 1040.000 2 YES %
1040.000 1060.000 3 YES

1060.000 1080.000 4 YES T
0.000 0.000 1 F

5. Set the Auto Range Options as follows:

Range Increment: 20
Minimum Elevation: 980
Maximum Elevation: 1180

Select Set Range to populate the table in the bottom portion of the dialog.
Close the Elevation Range dialog.

Return focus to the Themes dialog.

© © N o

Select Process.

Hint The resulting colored triangles (displayed in wireframe or filled/shaded depending on current
view options) are based solely on the triangles. This will provide and accurate result (based on
the data) but may be a little “jagged” for presentation purposes. Let’s try another dialog option
to improve the result.

10. Enable Number of Grid Points and set the value to 1,000,000.
11. Select Process.

This will take a few seconds to calculate and display a result, but the result will be significantly more

“presentable” that typically you will see with the triangle only based calculation.
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12. Select Slope Range Percent.
13. Disable Number of Grid Points.
14. Select Set Range

&b Slope Range - Percent ol & [

File

Range: [Auto Range Increment = |
Auto Range Options
Range Increment: | 10.000
Minimum Slope: | 0.000
Mandmum Slope: | 100.000

Set Range ] [ Create Legend ]
Low High Color Active =
0.000 10.000 D YES ‘E| al
10.000 20,000 1 yEs [
20,000 30.000 2 YES v
30.000 40000 3 YES
40,000 50.000 4 YES ~
0.000 0.000 =
Range Increment: 10
Minimum Slope: 0
Maximum Slope: 100

15. Select Set Range to populate the lower portion of the dialog.
16. Close the Slope Range — Percent dialog.
17. Select Process.

Hint As the slope range calculation is based solely on the triangle slopes, there is nothing to be

gained from enabling the grid points option. The results will be better and faster with that option
disabled.
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18. Select Aspect.

As the Slope Range — Percent and Slope Range — Degree are very similar in functionality, we shall
move on to the Aspect tool.

The Aspect tool (like the Slope Range tools) are very much triangle surface analysis tools. Disable the
Number of Grid Points option.

19. Select Set Range

&b Aspect Range =] @ =3

File

Range: [Auto Range Increment  ~ |
Auto Range Options
Range Increment: | 45.000
Minimum Aspect: | 0.000
Mandmum Aspect: | 360.000

Set Range J I Create Legend I
Low High Color Active =
0.000 45 000 D YES [|| &
45.000 50.000 1 YES |
50.000 135 000 2 YES v
135.000 180,000 3 YES
180.000 235 000 4 YES ~
0.000 0.000 =
Range Increment: 45
Minimum Aspect: 0
Maximum Aspect: 360

20. Select Set Range to populate the lower portion of the dialog.
21. Close the Aspect Range dialog.

22. Return focus to the Themes dialog.

23. Select Process.

Hint There are dialog options to create polygons of the resulting data and to create those polygons
at a specific elevation (flatten them).

The different aspects (the direction that the individual triangle faces point towards) will be colored based
on the ranges set.

24. Close the Themes dialog.
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EXERCISE: DRAINAGE TOOLS
The Analysis>Drainage tools are designed to provide feedback to a Designer related to typical

drainage type questions that a Civil designer may face.
Where does the water go?
Are there existing ponds? What volume do those ponds hold?

If | outlet water here —where does it go? How does water get to this location?

What are the existing catchment areas?
Where are my low points? Where are the high points?

THESE TYPES OF ANALYSIS CAN BE UNDERTAKEN WITH THE DRAINAGE ANALYSIS TOOLS PROVIDED BY GEOPAK.

USING THE DRAINAGE TOOLS — DELINEATE ALL WATERSHEDS

1. Select the Drainage Tools. (DTM Tool Frame: Analysis>Drainage Tools)

2. Select Delineate All Watersheds.
The Delineate All Watersheds tool displays the watershed boundaries that exist within a
DTM. Shapes may be created for each watershed contained in the TIN.

3. Set the dialog options as follows:

#L Delineate All Watersheds =] @ =3

TIN File: | Aerial tin Q,

Options

BB S S

Display Orly Watersheds
Load Within Fence —
Zero Slope Areas

Set Graphic Group

Mirimum Low _

Point Depth: | 0.500 Void Areas
[ Refine Watershed —1

| Apply |
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Display Only: Enabled

Load Within Fence Enabled
Set Graphic Group Enabled
Minimum Low Point Depth: 0.500

Refine Watershed: Disabled

Note The Refine Watershed option, when activated, processes the entire TIN evaluating ridges,
sumps, and low points and determines more precise flow boundaries within the triangles.

4. Select Apply.

The catchment areas, based on the TIN surface, will be displayed in the CAD file. Using the Min Low Point
Depth option will have removed a number of superfluous areas, but not all. The DTM analysis
should be regarded as a “first pass” that will assist in the final delineation of watershed areas...
these results should be reviewed and interpreted by a drainage engineer.

USING THE DRAINAGE TOOLS — DOWNSTREAM TRACE

1. Continuing in the Drainage tools dialog, select Downstream Trace.

<

2. Setthe dialog options as follows:

#L Downstream Trace =] @ =3
TIM File: | Agrial tin Q
Options

& &BS| S Y,

Display Onby =

Mirimum Low
Point Depth: | 0.500

[ Apply |

3. Click Apply
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4. Data point somewhere in View window 1 on the surface.
5. Continue to data point in various locations around the surface.

USING THE DRAINAGE TooLS — DELINEATE Low POINTS

1. Continuing in the Drainage tools dialog, select Delineate Low Points.

&L Delineate Low Points Eﬁ@

TIN File: | Aerial tin Q
Cptions

&R S Sy

Display Onby _

Load Within Fence

Set Graphic Group Amow Size: | 5.000
Mirimum Low

l Apply |

2. Populate the dialog as shown.
3. Select Apply.

The tool will analyze the TIN and indicate (with red arrows) the locations of the low points. With the Point
Depth value populated, any low point that is found to be less than 0.50 deep will be deemed as
an undulation and will be ignored.
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USING THE DRAINAGE TOOLS — SURFACE PONDS & POND ANALYSIS

1. Continuing in the Drainage tools dialog, select Surface Ponds.

~

2. Populate the dialog as shown.

M Surface Ponds (== =]
TIN File: | Aerial tin Q
Options

o
v Bl

Display Onby Ponds: | —
lelands: _

Set Graphic Group

[ Apply |

3. Select Apply.
The Surface Ponds tool delineates the area(s) of ponded water within the specified Aerial.tin file.

Hint Take note of a location where a large pond has been found. We will now analyze that specific
pond.
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4. Select Pond Analysis.

-

L Pond Analysis

TIN File: | Aerial tin Q,

Options

&AB S <y
ey G e

Ponds: | —
lelands: =

Display Onby

Wolume Cubic Feet

Pond Suface Area:
Madmum Surface Elevation:
Maximum Pond Depth:

n/a
n/a
n/a
n/a

[ Apply |

5. Populate the dialog as shown.
6. Select Apply.

7. Data point near where the large a pond had been identified.
B~

TIN File: | Aerial tin Q

&L pond Analysis

Cptions

8a% 5 <7
oy i

Ponds: [ —
|slands: =

Wolume Cubic Feet | 16555 969 CF
Pond Suface Area: 1074 846 5Y
Madmum Suface Blevation: 1059.933
Maximum Pond Depth:  4.943

[ ]

Display Onby

The Pond Analysis tool traces a point downstream to a low point and fills it giving the
volume, surface area, maximum depth, and maximum elevation. In addition, the pond
delineation is graphically displayed

8. Close the Drainage Tools dialog.
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EXERcise: VisiBILITY TOOLS

The Analysis>Visibility tools are designed to provide feedback to a Designer related to line of
sight and what is visible/invisible from a specific location.

Based on a user-defined point of origin, it visually displays lines of sight, which triangles can and
cannot be seen, or what is visible between two specified points.

This analysis toolset would typically be used for intersection line of sight review (when a 3D
dataset has been produced) or for studies of Site designs where taking advantage of or hiding a
view is of value to the Client.

Example: Being able to see the shore or hiding an old factory from a new residential
development...

Available visibility analysis options are:

1) Line of Sight

2) Surface Points
3) Surface Lines

4) Surface Regions

HL Visibility Tool [ = |[=

TIN File: | Aerial tin Q

Eve Position

@F’e"”'_”—'] LELS Evye Position: Sets the visibility start point.
Lasliad s 5.000 #—Optionally: A vertical offset "height of eye"
X: [1659369.97 can be set

Y. [277m13

Display Settings

Visible: | ——|

Not Visible: | ¢ Display Setting: symbology settinsg for

Display Onby
Graphic Group

what is visible and what is not visible

Vigibilty Parameters
Misibility Type:! [ Line of Sight -]
Drape on TIN ~| 1141.504 Visibility Parameters: Sets the type of
Offset Height: 1.000 #— analysis to be undertaken and the
¥ | 16607204 op "target” parameters
Y. [-275752.00

Process
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VISIBILITY TOOLS — LINE OF SIGHT

1. Select the Visibility tool. (DTM Tool Frame: Analysis>Visibility)
2. Set the TIN file to C:;/2009 RBC/GW1/DATA/Aerial.tin
3. Eye Position group:
4. Select Drape on TIN option.
5. Select DP and data point in the DTM area. Do not DP in a void...
6. Enable Offset Height and set the value to 5.0
7. Display Settings group:
Populate the dialog as shown.
Visibility Parameters group:
10. Set Visibility type to Line of Sight.
11. Select Drape on TIN option.
12. Enable/Disable Offset height option (your decision ©)

13. Select DP and data point within the data set... chose a location away from your Eye Position
location.

14. Select Process.

There will be a line drawn between the Eye Position location and the Visibility Parameters location. The
line will be “visible” or “not visible” or a combination of the two.

VISIBILITY TOOLS — SURFACE POINTS

In this tool, GEOPAK displays each triangle vertex in the model as visible or not visible. As the Eye
Position is defined at the top of the dialog, no additional user requirements are needed.

1. Select the Visibility Parameter type to Surface Points.
2. Select Process.
The TIN vertices will be color coded depending on visibility status (visible or not visible).

3. Move your Eye Position and Process again to review a different result.
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VISIBILITY TOOLS — SURFACE LINES

In this tool, GEOPAK displays each triangle edge in the model as visible or not visible. As the Eye
Position is defined at the top of the dialog, no additional user requirements are needed.

1. Select the Visibility Parameter type to Surface Lines.
2. Select Process
The TIN edges will be color coded depending on visibility status (visible or not visible).

3. Move your Eye Position and Process again to review a different result.

VISIBILITY TOOLS — SURFACE REGIONS

This option displays radials emanating from the original eye position with two options. The initial
radial always begins going Due East (horizontally to the right from the Eye Position). Radials are
determined by moving in a counterclockwise direction. When the Radial Angle is activated, the angle
is specified. The angle between each radial is the specified degrees. Therefore, GEOPAK determines
the number of wedges drawn. When Radial Number is the selected option, the input number of
radials is calculated and displayed within the 360 degree range.

1. Select the Visibility Parameter type to Surface Regions.

&b Visibility Tool =] @ =3

TIN File: | Aerial tin Q
Eye Position

Drape on TIN »| 1091.552
Offset Height: 5.000

X: | 166040021

Redraw

Y |-275050.70

Display Settings

Visible: ——— |

Not Visible: |
Display Only

Graphic Group [ Polygonize
Visibility Parameters

Visibility Type: |Surface Regions =
@ Radial Angle: 5.000

(7) Radial Number:

Process

2. Populate the dialog with a Radial Angle value of 5.0
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3. Select Process

Radial lines will be drawn from the Eye Position at 5 degree intervals to the extent of the TIN surface.
These radials will color coded based on what is “visible” or “not visible” or a combination of the
two from the Eye Position to the edge of the TIN surface.

4. Move your Eye Position and Process again to review a different result.
5. Close the Visibility Tool dialog.
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EXERCISE: TRACE SLOPE PATH

This exercise will guide you through the steps to use the Trace Slope path tool.

The tool will find a path up or down a DTM surface at a specific grade. The User can designate a slope
segment length or, if the length is set to zero (0), the tool will find the longest path possible at the
desired slope.

There are some caveats with this tool. For example; It is not possible to find a 10% path slope across
a surface which has only a 5% surface slope.

Reasonable input values must be applied and, to ensure that reasonable values are used, this tool
should be used in conjunction with the Height/Slope tool.

Select the Trace Slope Path tool. (DTM Tool Frame: Analysis>Trace Slope Path).
Set the TIN file to C:/2009 RBC/GW1/DATA/Aerial.tin.
Zoom to a specific area of data.

Open the Height/Slope tool and ascertain the surface slope in the area of focus.

o~ b=

Populate the dialog similarly to what you see below ensuring that the Trace Slope value is LESS
that the surface slope in the area of focus.

o Trace Slope Path El =] @

TIM File: | Agrial tin o}
Method
@ Follow Slope () Direct Slope
[Slope % -||-8.000
Distance: | 0.000
Display Settings

/| Display Cnly =

6. Select DP and data point into the DGN within the area of focus.

The tool will trace a slope across the surface triangles at the requested slope value for as long a path as is
possible.

7. Modify the dialog settings and view the alternate results.

Hint The slope value is sensitive to “sign” (-/+).

8. Discuss options with your instructor.
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